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About this Guide
This guide provides all the information that you need to prepare for the 
iLife ’09 exam and earn Apple Certified Associate certification. Certification 
allows you to distinguish yourself to colleges or prospective employers as a 
skilled user of the iLife product suite.

The iLife ’09 Exam (Prometric exam no. 9L0-808) is a computer-based test 
offered at Apple Authorized Training Centers (AATCs) and online to eligible 
individuals who have a promotional code.

You may take up to an hour to complete the exam, which consists of 60 
multiple choice, fill-in-the-blank and interactive media questions. The 
questions are based on the objectives listed in this guide.

The score required to pass is 80 percent. To prepare for the exam, read 
through the objectives in this guide to determine which areas you need to 
review. The primary reference source for this exam is the book: Apple 
Training Series: iLife '09 (ISBN 0-321-61850-5).

You are not allowed to access any resources or references during the 
exam, and you may not have the iLife application open during the exam. 
Please note that although this guide divides the objectives into knowledge 
areas, questions are presented randomly during the exam. 

Benefits of Apple Certification
Apple’s Training and Certification programs are designed to keep you at 
the forefront of Apple’s digital media technology. Certification creates a 
benchmark for assessing your proficiency in a specific application. Apple 
Certified Associate status validates entry level skills in our digital lifestyle 
and authoring applications, and allows you to distinguish yourself to 
colleges, employers, and prospective clients as a skilled user of the chosen 
software application. 

Once you pass your iLife exam, you will receive an email with your PDF 
certificate and the option to purchase a printed certificate, framed or 
unframed. You will also be able to log in to the Apple Certification Records 
system to access your new Apple Certification logo, and publish your 
listing on the Apple Certified Professionals Registry. Please note that you 
must be at least eighteen years of age to publish your listing on the public 
directory. 

Preparing for Your Exam 
In addition to experience with the application and reviewing the Apple 
Training Series: iLife book, the following resources may help you to prepare 
for your certification exam:

• If you prefer hands-on classroom learning, check our course schedule 
for a list of iLife classes available at Apple Authorized Training Centers 
(AATCs) worldwide.
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• Documentation for all Apple products is available at www.apple.com/
support/manuals. You can also choose Help > User Manual when one 
of the iLife applications is launched.

• If you are new to the Macintosh, you may want to review the tutorials 
at: http://www.apple.com/support/mac101/ and http://
www.apple.com/findouthow/mac/.

• Many online resources allow you to ask questions and learn tips and 
tricks. Access white papers, discussion forums, and other online 
materials on the iLife resources page: http://www.apple.com/ilife/
resources/.

• Review the free tutorials at: http://www.apple.com/ilife/tutorials/.

• Take the guided tours at http://www.apple.com/ilife/iphoto/guided-
tour/ and http://www.apple.com/ilife/imovie/guided-tour/.

• Read the late breaking news at www.apple.com/support/manuals/. 

The Apple Training Series curriculum
Apple Training Series: iLife ’09 is part of the official Apple Certified curriculum 
and is designed to prepare you for the certification exam. 

However, if you have learned on your own from other resources, or taken 
courses that do not use the Apple curriculum, you may still prepare 
yourself for the certification exam by making sure that you can complete 
all the tasks that are described in the following sections. You should also 
make sure that you can answer all the review questions for each section. 
Answers are provided in the section following the questions. 

The number of test questions drawn from each knowledge area is 
indicated for each of the following lessons. Please note that although this 
guide divides the objectives into 13 lessons or knowledge areas, questions 
are presented randomly during the exam. Apple Training Series: iLife ’09 
includes 17 lessons. Please note that the end user exam does not include 
questions from Lessons 14 through 17, although the Apple Certified Trainer 
exam includes questions from all chapters.

Lesson One objectives
Upon completion of Lesson One, “Importing and Organizing Your Photos” 
in Apple Training Series: iLife ’09, you should be able to complete the 
following tasks. Approximately seven items from this lesson are included in 
the pool of exam questions, drawn randomly from the following objectives:

• Learn basic photographic terms and techniques

• Learn how to connect a camera to your Mac

• Import photos and video from a camera into iPhoto

• Import picture files into iPhoto

• Create and organize Events

• Identify faces in your photos
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• Identify your photos by places

Lesson One review questions
After completing Lesson One, you should be able to answer the following 
questions: 

1. What is the rule of thirds and how will adhering to it improve 
your pictures?

2. What is GPS?

3. How can you control whether iPhoto opens automatically 
when you attach a camera to your Mac?

4. How can you tell if an item to be imported from your camera 
is a video rather than a still image?

5. How can you import image files into iPhoto?

6. What is an Event?

7. How can you see the faces that iPhoto has recognized in a 
photo?

8. How can you change the name of a place?

Answers

1. The rule of thirds helps improve a photo’s composition by 
positioning the photo’s subject a third of the way from the 
sides, top, or bottom of the photo rather than in the direct 
center.

2. GPS is the Global Positioning System, consisting of a group of 
satellites that transmit signals that terrestrial receivers can use 
to pinpoint locations. Some cameras contain GPS receivers.

3. Open iPhoto’s preferences and choose iPhoto from the 
“Connecting camera opens” menu in General preferences.

4. Video thumbnails have a small white video camera icon in 
their lower-left corners.

5. You can import image files either by dragging them to the 
iPhoto icon in the Dock, or by dragging them to the iPhoto 
window.

6. A collection of pictures taken around the same time.

7. Select the photo and then click the Names button.

8. Choose Window > Manage My Places, and then edit the 
name in the Edit My Places list.

Lesson Two objectives
Upon completion of Lesson Two, “Importing and Organizing Your Photos” 
in Apple Training Series: iLife ’09, you should be able to complete the 
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following tasks. Approximately nine items from this lesson are included in 
the pool of exam questions, drawn randomly from the following objectives:

• Compare and rate photos

• Give your photos keywords

• Search for photos by name, keyword, or rating

• Make quick fixes to photos

• Retouch and color-correct photos

• Use special effects

Lesson Two review questions
After completing Lesson Two, you should be able to answer the following 
questions: 

1. What does cropping mean?

2. Give a reason for cropping a picture.

3. What is red-eye?

4. What is a common cause for crooked pictures?

5. What is color cast?

6. Which iPhoto tool is used to correct color cast problems?

7. Where in a picture might the Retouch tool produce odd 
results?

8. Describe a side effect of using the Straighten tool.

Answers

1. Cropping is the act of trimming the edges from a picture.

2. There are several reasons to crop a picture: To improve the 
composition, to remove unwanted elements from the 
picture, to highlight a specific detail in the picture, and to 
change the picture’s shape.

3. Red-eye is the glowing-eye effect created when the light 
from the camera’s flash illuminates the blood vessels at the 
back of the photographic subject’s eyes.

4. Crooked pictures are often caused by inadvertently tilting the 
camera when pressing the shutter button.

5. A color cast is a tinting of the picture created when the 
camera unsuccessfully compensates for the color of the light 
present when the picture is taken.

6. The White Point eyedropper tool in the Adjust pane is used to 
correct color cast problems.

7. Using the Retouch tool along the edge of an object in a 
picture can cause odd artifacts and smears to appear.
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8. The Straighten tool has the side effect of slightly cropping the 
picture.

Lesson Three objectives

Upon completion of Lesson Three, “Sharing Your Photos” in Apple Training 
Series: iLife ’09, you should be able to complete the following tasks. 
Approximately six items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Create albums and Smart Albums

• Share your photos on a network

• Sync photos to an iPod or iPhone

• Display your photos in a screen saver

• Build a photo slideshow

• Put your photos online with MobileMe, Flickr, and Facebook

Lesson Three review questions
After completing Lesson Three, you should be able to answer the following 
questions: 

1. What is an album?

2. Describe two ways to rearrange the order of photos in an 
album.

3. What is a Smart Album?

4. How can you create an album that contains photos of your 
family?

5. How can you email photos from your iPhoto library without 
opening iPhoto?

6. Why would you want to rearrange the order of your photo 
albums in the iTunes Photo syncing tab?

7. What is a slideshow theme?

8. How can you add photos to MobileMe Gallery without using 
iPhoto?

9. How do you sync pictures between iPhoto and Flickr or 
Facebook?

Answers

1. A collection of photos from one or more Events; the iPhoto 
equivalent of an iTunes playlist.

2. Drag the photos into the order you want, or choose a sorting 
order from the View > Sort Photos submenu.
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3. A Smart Album is an album that contains just the photos 
matching the conditions that you’ve specified and that 
dynamically changes its contents as necessary.

4. Use Faces to identify photos of each family member, and then 
make a Smart Album with multiple conditions, one for each 
family member’s name.

5. In Apple’s Mail application, click the iPhoto Browser button 
that appears at the top of each mail message you create and 
select the photos from the iPhoto Browser window that 
appears.

6. iTunes syncs photo albums in top-to-bottom list order; if the 
device to which you are syncing photos is almost full, the 
albums at the top of the list are more likely to sync to the 
device before it completely fills up.

7. A slideshow’s theme controls the basic visual style of the 
slideshow, the transitions between slides, and the default 
music that accompanies the slideshow.

8. Make sure that the Gallery is configured to allow photo 
uploads from a web browser and from email. Then go to the 
Gallery in your web browser and use the Upload button, or 
email the photo to the Gallery’s email address.

9. In the Source list, to the right of the published album’s name, 
click the small Publish icon.

Lesson Four objectives

Upon completion of Lesson Four, “Publishing Your Photos” in Apple Training 
Series: iLife ’09, you should be able to complete the following tasks. 
Approximately four items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Print photos

• Order prints

• Make a photo book

• Make and order a greeting card

• Back up photos

Lesson Four review questions
After completing Lesson Four, you should be able to answer the following 
questions: 

1. How can you save a snapshot of your iPhoto library?

2. What do you have to do to back up your iPhoto library with 
Time Machine?

3. What is a theme?

4. What is a layout?
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5. What do you need an Apple account for?

6. What does a yellow warning icon mean when you see it on a 
picture in a card, calendar page, or book page, or by a print 
size on a print order form?

7. What aspect ratio should pictures have in a book?

8. How can you preview how your picture book will look when 
printed, without ordering it?

Answers

1. Record a copy of it on a recordable CD or DVD by using the 
Burn command.

2. Make sure that Time Machine is turned on and backing up 
your Mac to a backup drive. Time Machine automatically 
backs up your library along with other changes you make on 
your Mac, at regular intervals.

3. A theme is a collection of visually related layouts for printing 
or display. When you create a greeting card, picture book, or 
calendar project, you begin by choosing a theme. You can 
change a project’s theme at any time.

4. A layout is a particular arrangement of items on a page. For 
example, one page in a picture book may use a single-picture 
layout, and the next page may use a four-picture layout.

5. You need an Apple account to buy professionally printed 
copies of picture prints, books, greeting cards, and calendars 
using iPhoto.

6. The yellow warning icon appears when a picture’s resolution 
is too low for it to look good when it’s printed professionally.

7. Picture books are designed to use pictures that have a 4:3 
aspect ratio.

8. Control-click or right-click in the gray region beside a page in 
the book’s layout area and then choose Preview Book. You 
can also click Slideshow to preview the book as a full-screen 
slideshow.

Lesson Five objectives
Upon completion of Lesson Five, “Instant Moviemaking; Creating Your First 
iMovie” in Apple Training Series: iLife ’09, you should be able to complete the 
following tasks. Approximately nine items from this lesson are included in 
the pool of exam questions, drawn randomly from the following objectives:

• Understand how to create a new iMovie project

• Organize Events in the Event Library

• Understand the video skimming, playback, and selection tools

• Assemble, adjust, and reorder clips in your project
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• Learn how to add transitions to your movie

• Add background audio

• Apply a theme to your movie

• Customize the theme transitions

• Learn how to do it all in 30 minutes or less

Lesson Five review questions
After completing Lesson Five, you should be able to answer the following 
questions: 

1. Where do you view your raw footage?

2. Are rejected clips automatically deleted from the hard disk?

3. Name two ways to add clips to a project.

4. True or false: Once a clip is added to a project, its length can’t 
be changed.

5. Where can you zoom in on a clip?

6. How do you change the exposure of a clip?

7. How do you preview different transition effects on the clips in 
your project?

8. Where do you drop an audio file to add it to the background?

9. How do you customize the still frames used in a theme 
transition?

10. Where do you set the name of the cities displayed on a map?

Answers

1. In the Event Browser.

2. No, they’re just hidden in the default Event Browser view.

3. Drag to the Project Browser, click the “Add to Project” button, 
or press E.

4. False.

5. In the Crop, Rotate and Ken Burns window.

6. Click the Clip pop-up menu, choose Video Adjustments, and 
drag the Exposure slider.

7. In the Inspector, click the Transition button and skim or play 
over the different effects.

8. Drop it on the gray background in the Project Browser.

9. Double-click the transition and move the numbered markers 
in the Project Browser.

10. In the “Name to display on map” field of the Map Inspector.
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Lesson Six objectives
Upon completion of Lesson Six, “Tell All the World: Sharing and Publishing 
Your First iMovie” in Apple Training Series: iLife ’09, you should be able to 
complete the following tasks. Approximately four items from this lesson are 
included in the pool of exam questions, drawn randomly from the 
following objectives:

• Play your movie and your source footage full screen

• Learn how to share your movies in a variety of sizes and formats using 
iTunes

• Understand how to send your movies to GarageBand, iDVD, and iWeb

• Publish your movies to YouTube and your MobileMe Gallery

• Prepare to burn a DVD of your movie

• Export to QuickTime

Lesson Six review questions
After completing Lesson Six, you should be able to answer the following 
questions: 

1. How do you switch between playing projects and playing 
Events in the Full Screen Viewer?

2. How many file sizes can you publish to iTunes?

3. When published to iTunes, where are your movies stored?

4. Do you have to choose between sharing to YouTube or 
Sharing to MobileMe?

5. How do you share movie files between iMovie and 
GarageBand?

6. If the Share to Media Browser menu item is dimmed, what 
does that indicate?

7. How do you make the Comment Marker and Chapter Marker 
buttons available?

8. How do you add a chapter marker to your video??

Answers

1. Click the “Show Projects or Events” button in the lower-left 
corner.

2. iMovie has four file-size options: Tiny, Mobile, Medium, and 
Large.

3. They can be found in the Movies folder within your iTunes 
Music folder.

4. No. You can share your video to both YouTube and your 
MobileMe Gallery.
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5. Publish to the iLife Media Browser, which exports a rendered 
movie that is easily available within GarageBand.

6. All four sizes have already been shared to the Media Browser 
or to iTunes (which makes them accessible to the Media 
Browser).

7. Select Advanced Tools in the iMovie General preferences.

8. Drag the Add Chapter Marker button directly to your video in 
the Project Browser.

Lesson Seven objectives
Upon completion of Lesson Seven, “Making Your Masterpiece: Shooting 
and Importing Video” in Apple Training Series: iLife ’09, you should be able to 
complete the following tasks. Approximately one item from this lesson is 
included in the pool of exam questions, drawn randomly from the 
following objectives:

• Learn to shoot for the edit

• Master the three rules of camera movement

• Import footage footage into iMovie from a variety of camera types

• Import video files already on your disk

• Organize your footage with keywords

Lesson Seven review questions
After completing Lesson Seven, you should be able to answer the 
following questions: 

1. What is coverage?

2. What is the single most important rule of camera movement?

3. If you know you’re going to be relying on iMovie’s video 
stabilizer, what can you do to improve your chances of 
getting a good shot?

4. When should you capture 1080i footage at the full setting?

5. How do you see movie clips shot with a still camera?

6. How do you unmark a clip that you already rejected?

7. What preference must be set to add keywords to your shots?

8. How do you filter the view of the Event Browser to show only 
footage with a certain keyword applied?

Answers

1. All the different shots photographed for a single event.

2. Never move the camera without a reason.
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3. Hold the camera as steady as possible, and frame your 
subject with extra space around it.

4. When you’re going to be projecting your movie on a very 
large HD screen.

5. Import them along with your still images into iPhoto, and 
they’ll automatically appear in the iMovie Event Library in the 
iPhoto Videos category.

6. Set the Event Browser to Show All (or show Rejected Only), 
select the section you want to unmark, and click the Unmark 
button or press U.

7. Show Advanced Tools.

8. Show the Keyword Filtering Pane and click the green button 
next to the keyword in the list.

Lesson Eight objectives
Upon completion of Lesson Eight, “The Cutting Edge: Advanced Editing 
Techniques” in Apple Training Series: iLife ’09, you should be able to 
complete the following tasks. Approximately three items from this lesson 
are included in the pool of exam questions, drawn randomly from the 
following objectives:

• Learn some fundamental editing rules and guidelines

• Use insert, replace, and other advanced editing techniques

• Employ cutaways to create flexible edits

• Use the Clip Trimmer and Precision Editor with confidence

Lesson Eight review questions
After completing Lesson Seven, you should be able to answer the 
following questions: 

1. Where can you access videos shot with a still camera or 
otherwise imported into iPhoto?

2. Does inserting a clip cover up existing footage?

3. Does a cutaway cover up existing footage?

4. How many ways are there to replace a shot?

5. If you replace a five-second shot with a ten-second shot, how 
long will the resulting shot be?

6. How do you open the Clip Trimmer?

7. How do you open the Precision Editor?

8. Can you modify both clips in the Precision Editor at the same 
time?

9. Can the Precision Editor modify audio or just video?
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Answers

1. In the iPhoto Videos section of the Event Library.

2. No. It pushes the old footage out of the way to make room 
for the new shot.

3. Yes. Cutaways cover the footage under them.

4. There are four: Replace, Replace from Start, Replace from End 
and Replace at Playhead.

5. It depends on which kind of replace you choose. A simple 
replace will result in the whole ten-second new clip. All the 
other replace methods will result in a five-second clip.

6. Select Clip Trimmer from the Action pop-up menu for any 
clip.

7. Select Precision Editor from the Action pop-up menu on any 
clip, or double-click the space between two clips.

8. Yes. Drag the blue ball in the gray edit bar.

9. The Precision Editor can trim both audio and video.

Lesson Nine objectives
Upon completion of Lesson Nine, “Hollywood Here I Come: Creating Visual 
Effects” in Apple Training Series: iLife ’09, you should be able to complete the 
following tasks. Approximately four items from this lesson are included in 
the pool of exam questions, drawn randomly from the following objectives:

• Incorporate still images and animate them using the Ken Burns tool

• Add and customize animated titles

• Apply video effects to create unique visual looks

• Modify clip speed to create slow motion and backward playback

• Create a freeze frame effect

• Use the Video Adjustments inspector to fix color and contrast errors

• Learn to use and control the video stabilization feature

• Create special compositing effects using green-screen footage.

Lesson Nine review questions
After completing Lesson Nine, you should be able to answer the following 
questions: 

1. Where are still photos from iPhoto available in iMovie?

2. How do you apply video effects like Aged Film or Vignette?

3. If you play a five-second clip at 50% speed (slow motion), 
how long will the clip be?
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4. True or false: Once you apply automatic transitions, you can’t 
add or modify any transitions in the project.

5. Does the Auto button in the Video Adjustments inspector fix 
whitebalance errors?

6. True or false: Video stabilization can stabilize any footage, no 
matter how shaky.

7. What do the red squiggly lines indicate?

8. True or False: The green-screen function will work on shots 
with a blue background.

9. True or false: The green background must cover the entire 
background.

Answers

1. In the Photos Browser.

2. In the Clip Adjustments inspector, click the Video Effects 
button.

3. Ten seconds.

4. False. But making any changes requires turning off automatic 
transitions.

5. No. It improves contrast.

6. False.

7. Areas of excessive shakiness that iMovie can’t stabilize.

8. False. The background must be green.

9. False. You can crop out areas that are not green.

Lesson Ten objectives
Upon completion of Lesson Ten, “If Seeing Is Believing: Working with 
Audio” in Apple Training Series: iLife ’09, you should be able to complete the 
following tasks. Approximately three items from this lesson are included in 
the pool of exam questions, drawn randomly from the following objectives:

• Normalize clip volumes to ensure consistency

• Perform an Audio Only edit

• Add music and sound effects to your project

• Adjust audio levels and audio fades

• Record and adjust a voiceover track

• Understand ducking to control other audio clips
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Lesson Ten review questions
After completing Lesson Ten, you should be able to answer the following 
questions: 

1. What does it mean to normalize a clip?

2. Does ducking change the volume of the selected audio track?

3. Are audio fades added automatically to video clips?

4. How can you add realistic sound effects to your movie?

5. How can you change where background music begins in 
your project?

Answers

1. To normalize clip volume means to bring the audio of a clip 
to a preset uniform level.

2. No. Ducking reduces the volume of any audio that overlaps 
the track for which ducking has been selected.

3. Yes. iMovie adds an automatic half-second fade to the start 
and end of every video clip. To remove the fade, open the 
Audio Adjustments window and slide the Manual Fade slider 
to zero seconds.

4. Don’t just place a sound effect and move on. When you add a 
sound effect to your movie, be sure to adjust the volume level 
and fade to fit appropriately within the aural context of your 
movie.

5. Drag the background music by its name to where you want it 
to start.

Lesson Eleven objectives
Upon completion of Lesson Eleven, “Learning to Play Music with 
GarageBand” in Apple Training Series: iLife ’09, you should be able to 
complete the following tasks. Approximately two items from this lesson are 
included in the pool of exam questions, drawn randomly from the 
following objectives:

• Connect instruments to the computer

• Explore the Learn to Play interface

• Customize the Learn To Play appearance

• Download additional Learn To Play lessons

Lesson Eleven review questions
After completing Lesson Eleven, you should be able to answer the 
following questions: 

1. Which instruments have Learn to Play lessons included with 
GarageBand?
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2. How do you download additional lessons?

3. Do you have to have an instrument connected to the 
computer to take a Learn to Play lesson?

Answers

1. GarageBand includes Learn to Play lessons for both Piano and 
Guitar.

2. You click the Lessons Store button on the GarageBand Project 
dialog, then choose the lesson that you want to download.

3. You can take a Learn to Play lesson with or without an 
instrument; however, having a Guitar or Keyboard connected 
to the computer allows you to tune (for guitars) and play 
along with the instructor during the lesson.

Lesson Twelve objectives

Upon completion of Lesson Twelve, “Jamming with a Virtual Band” in Apple 
Training Series: iLife ’09, you should be able to complete the following tasks. 
Approximately five items from this lesson are included in the pool of exam 
questions, drawn randomly from the following objectives:

• Choose a Magic GarageBand Jam genre

• Audition and select instrument parts

• Work with the mixer during an audition

• Select and customize your instrument part

• Record a keyboard part using musical typing

• Open and save a finished song

Lesson Twelve review questions
After completing Lesson Twelve, you should be able to answer the 
following questions: 

1. How do you select an instrument in Magic GarageBand Jam?

2. Can you add or change Magic GarageBand instruments?

3. How do you isolate the sound of an instrument in Magic 
GarageBand?

4. Is there a way to have Magic GarageBand change all of the 
instruments for you?

Answers

1. You can select an instrument in Magic GarageBand Jam by 
rolling over the instrument and clicking the instrument.

2. You can change any Magic GarageBand instrument by 
selecting the instrument and choosing another instrument in 
the menu. To add an instrument in the My Instrument 
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category, click the Customize button and then choose an 
instrument from the list.

3. To isolate the sound of an instrument in Magic GarageBand, 
you can turn on the Solo button in the instrument’s mixer.

4. You can have Magic GarageBand automatically change all of 
the instruments to a different combination by moving to an 
empty space on the stage, and then clicking the Shuffle 
Instruments button when it appears.

Lesson Thirteen objectives
Upon completion of Lesson Thirteen, “Jamming with a Virtual Band” in 
Apple Training Series: iLife ’09, you should be able to complete the following 
tasks. Approximately five items from this lesson are included in the pool of 
exam questions, drawn randomly from the following objectives:

• Create a loops-based ringtone

• Record a Software Instrument part

• Play the onscreen Music Keyboard

• Send a ringtone to iTunes

• Edit a Real Instrument voice track

• Edit regions in the editor

• Merge Real Instrument regions

Lesson Thirteen review questions
After completing Lesson Thirteen, you should be able to answer the 
following questions: 

1. How do you select an instrument in Magic GarageBand Jam?

2. Can you add or change Magic GarageBand instruments?

3. How do you isolate the sound of an instrument in Magic 
GarageBand?

4. Is there a way to have Magic GarageBand change all of the 
instruments for you?

Answers

1. You can select an instrument in Magic GarageBand Jam by 
rolling over the instrument and clicking the instrument.

2. You can change any Magic GarageBand instrument by 
selecting the instrument and choosing another instrument in 
the menu. To add an instrument in the My Instrument 
category, click the Customize button and then choose an 
instrument from the list.

3. To isolate the sound of an instrument in Magic GarageBand, 
you can turn on the Solo button in the instrument’s mixer.
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4. You can have Magic GarageBand automatically change all of 
the instruments to a different combination by moving to an 
empty space on the stage, and then clicking the Shuffle 
Instruments button when it appears.

Taking a Prometric Prime Practice Exam
If you have never taken a Prometric online exam, you can familiarize 
yourself with the interface by taking a practice exam.  The exam is free and 
you can take it from home using the following instructions. Please note 
that the exam does not cover any of the iLife exam content; it only includes 
four generic questions, one of each of the types that are common on 
Apple Certification exams: 

• Multiple choice, single response 

• Multiple choice, multiple response 

• Multiple choice, single response, with a calculator available 

• "Hot Spot" interactive media 

The tutorial also describes how to select answers, move between items, 
and how to review the test items list on the Summary page of the test. 

1. Note that the Prometric Prime online testing system does not 
support the Firefox browser. You should use Safari 3.2.1.

2. Log on to http://ibt.prometric.com/apple. Please note that the 

3. Click First-Time Registration and follow the instructions to 
create a Prometric Prime ID and password.  

4. Click Continue to access the Candidate Menu page.

5. In the Candidate Menu page, click Take Test.

6. Click Submit in the first box, labelled Public Tests. 

7. Open the Miscellaneous folder and click 9L0-002 - Prime 
Tutorial - English (US) - Free test. 

8. Click Begin Test at the bottom of the page.

9. When you finish all the questions, click End Test.

Taking the Certification Exam
As a special offer, owners of the Apple Training Series books GarageBand 
’09 or iLife ’09 are eligible to take the iLife ’09 certification exam online for 
$45.00 USD. Normally you must pay $65.00 USD to take the exam in a 
proctored setting. If you have an exam code from one of these books, you 
can use the following instructions to take the exam online. If you do not 
have a code, you can take your exam at an Apple Authorized Training 
Center (AATC). 

1. Note that the Prometric Prime online testing system does not 
support the Firefox browser. You should use Safari 3.2.1.
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2. Log on to http://ibt.prometric.com/apple, click Secure Sign-In 
(uses SSL encryption) and log in with your Prometric Prime 
ID and password. If you don’t have a Prometric Prime ID, 
click First-Time Registration and follow the instructions to 
create an ID and password. 

3. Click Continue to verify your information and access the 
Candidate Menu page.

4. In the Candidate Menu page, click Take Test.

5. Enter the appropriate code in the Private Tests box and click 
Submit. The codes are case sensitive and are only valid for 
one use.   

6. Click Take This Test and then Continue to skip the voucher 
then enter your credit card information to pay the $45.00 USD 
fee.

7. Click Begin Test at the bottom of the page.

8. When you finish, click End Test. If you do not pass the exam, 
retake instructions are included in the results email from 
Prometric.  You have to wait eight days before you can take 
the exam again, so please plan accordingly.
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For More Information
Please visit www.apple.com/training for 
more information about all Apple 
training courses and certification 
programs.
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